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Product Proficiency Exam Bulletin

Adobe® InDesign CS5
Exam # 9A0-142

ACE Certification Checklist

The checklist below will help guide you through the process of obtaining ACE certification.

• Review this bulletin to become familiar with the topic areas and objectives of the exam.

• Identify the topic areas and objectives you need to study.

• Determine which study materials you need to improve your skills. 

• For a list of recommended study materials, visit:
http://www.adobe.com/misc/training.html

• Study for the exam.

• Contact Pearson VUE to register for an exam: http://www.pearsonvue.com/adobe

• When registering for the exam, refer to the exam number located at the top of this bulletin.

• Take the exam.Your score is electronically reported to Adobe and will also be displayed 
when you complete your exam.

• Upon passing the exam, your certificate will be sent to you via email. Please ensure that 
you have provided an accurate email address.

• You can update your certification profile by going to: http://www.adobe.com/support/
certification/community.html. You will need the information provided on your score report 
to create a user account.
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Exam Structure

The following lists the topic areas and percentage of questions delivered in each topic area:

Number of Questions and Passing Score

• 72 questions

• 78% minimum required to pass

Test Content: Topic Areas and Objectives

Following is a detailed outline of the information covered on the exam.

1. Laying out a document

• Create a new document with settings appropriate for print or onscreen display.

• Adjust the size and position of one or more pages in a document with the Page tool.

• Given a scenario, work with master pages (scenarios include: locking master page items; 
loading, creating, and applying master pages; based-on master pages; overriding master 
page items; text wrap).

• Create a grid of objects while using the Place cursor, the Frame tools, or Selection tool.

• Use the Gap tool to change the size or position of gaps and frames.

• Use Layers to organize the structure of a document (scenarios include naming, arranging, 
and managing objects and groups).

• Explain the process of using Data Merge to build a template and import data into a final 
InDesign or PDF document.

• Modify and transform objects by using the transformation tools and the Control panel 
(including scaling, rotating, and resizing).

• Create, apply, and modify an object style.

• Create, edit, and manipulate text on a path.

• Describe the use of Smart Guides and the Smart Cursor (including their preferences).

Topic Area % of
Exam

# of
Questions

Laying out a document 18% 13
Working with text 21% 15
Working with tables 7% 5
Managing graphics 10% 7
Understanding color and transparency 8% 6
Creating and working with long documents 10% 7
Building Interactive Documents 8% 6
Importing, exporting, and working with cross-media 8% 6
Managing prepress and printing 10% 7
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• Rotate page spreads and, when required, clear the rotation.

• Use the CS Review panel to start a review, invite participants, and manage comments.

2. Working with text

• Insert special characters by using the Type menu, Glyph panel, or context menu.

• Given an option, edit text (options include: Story Editor, Drag and Drop text, Autocorrect).

• Adjust the look of text inside a text frame by using Text Frame Options (including columns, 
inset spacing, first baseline offset, balanced columns, and vertical justification).

• Given a scenario, set a paragraph to span across more than one text column or split into 
multiple sub-columns.

• Manipulate text flow by using text threading, smart text reflow, resizing, and text wrap 
(including ignore text wrap).

• Given a scenario, create and apply styles in an automated fashion (scenarios include next 
paragraph, nested styles, grep styles).

• Manage review and editing using Track Changes.

• Create a user dictionary and populate it with custom words.

• Import an RTF or Word file and map style names to styles in the current document.

• Assign and format automatic bullets or numbering to paragraphs (including numbering 
across multiple non-threaded frames).

• Given a scenario, set up a document or frame-based baseline grid.

• Make a dynamically changing running head (options include: text variables, section 
marker).

• Create and apply text conditions and condition sets, including synchronizing across 
documents in a book.

• Given a feature, avoid widows, orphans, and other typographic problems (using features 
such as Keep Options, Justification, Hyphenation).

3. Working with tables

• Modify tables (options include: adding or removing columns/rows; merging cells; splitting 
cells; selecting cells).

• Edit and format a table (options include: formatting text, editing tables in the Story Editor, 
adding Notes, strokes and fills; text alignment).

• Create, apply, import, modify, and organize cell and table styles.

• Update the information in a table when the original data has changed (via linking or copy/
paste).

4. Managing graphics

• Given a scenario, determine the best settings for choosing and placing an image (options 
include import options, Illustrator artboards, choice of file format, resolution, ICC color 
profiles, layers, and transparency).
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• Given a scenario, configure the Links panel to reveal metadata and attributes such as 
current image resolution.

• Create a graphic frame that resizes its content automatically.

• Hide or show layers in placed PSD, AI, INDD, and PDF files, and discuss how image 
transparency is handled.

• Manage placed files by using the Links panel (including revealing metadata and attributes 
in Link Info, editing the original, relinking to new files, and updating modified files).

• Create a caption for a graphic based on the image's metadata.

5. Understanding color and transparency

• Explain the use of named swatches versus unnamed colors.

• Given a scenario, create, modify, and apply gradients to objects or text using the 
appropriate panels and tools.

• Describe how and why to create mixed inks.

• Assign transparency effects to stroke, fill, and image/text individually (options include 
such as opacity, blending modes, drop shadows, feathering, and other effects).

• Given a scenario, choose the best course of action to manage color (options include 
Transparency Blend Space, Color Settings, Overprint Preview, ICC profiles, mixed RGB 
and CMYK).

6. Creating and working with long documents

• Insert and format footnotes in a document.

• Create a book in a book panel and paginate the documents.

• Create a table of contents across one or more documents.

• Synchronize master pages, styles, and swatches in a book

• Define and insert text variables.

• Create and apply cross-references, edit cross-reference format.

7. Building Interactive Documents

• Create interactivity for an InDesign document that will be exported as a PDF or SWF 
document (including adding movies, animations, sounds, multistate objects, and buttons).

• Describe how to view, import, and control video and sound files, and to preview interactive 
document elements inside InDesign.

• Create functional hyperlinks in exported PDF documents or SWF files (options include 
Hyperlinks panel, Table of Contents, Cross-References, and Buttons).

8. Importing and exporting for cross-media

• Given a scenario, choose the correct options to export document content to Flash 
Professional CS5.

• Given a scenario, choose the correct options to export a story or document to the ePub or 
XHTML format.

• Given a scenario, choose the correct features and settings to create an interactive PDF file.
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• Define and assign XML tags, and export an XML file.

• Map styles to tags and XML tags to styles using the Tags panel and the Structure view.

9. Managing prepress and printing

• Troubleshoot common printing issues by using Live Preflight (options include using Basic 
profile to locate and correct errors, create custom profile, create a Preflight report, share 
profiles).

• Troubleshoot common printing issues by using the Separations Preview panel (options 
include process inks, spot colors, ink density, and the Ink Manager).

• Given a scenario, choose the appropriate Print dialog box options (options include Printers 
Marks, Bleeds, Output Space, PPD fonts).

• Given a scenario, choose the appropriate PDF Preset or PDF Export settings.

Practice Exam

Try out these practice questions to get a feel for the types of questions on the ACE exam. Please 
note that your performance here does not indicate how you will do on the actual exam. To fully 
prepare for the exam, closely review the topic areas and objectives in this Exam Bulletin.

2.1 Insert special characters by using the Type menu, Glyphs panel, or context menu.

You want to save a group of 20 special characters from several different fonts that you fre-
quently need to insert into your InDesign documents. Which feature should you use?

A. Glyph Set

B. Libraries

C. Character Styles

D. Find Font

E. Text Variables

Correct answer: A

3.1 Modify tables (options include: adding or removing columns/rows; merging cells; 
splitting cells; selecting cells).

How can you select all of the cells in a table?

A. Click the Type tool on the upper-left corner of the table

B. Click the Type tool on the upper-right corner of the table

C. Click your Type tool in the table and press Command-A (Mac) or Ctrl+A (Windows)

D. Hold down the Option (Mac OS) or Alt (Windows) key and click on a table cell edge with 
the Direct Selection tool.
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Correct answer: A

3.3 Create, apply, import, modify, and organize cell and table styles. 

You have created a table style and wish to have it applied when you place an Excel file. You 
choose File > Place and select the Show Import Options check box. Which option should you 
choose from the Table pop-up menu in the Formatting section of the Import Options dialog 
box?

A. Formatted Table 

B. Unformatted Table 

C. Formatted Only Once 

D. Unformatted Tabbed Text 

Correct answer: B

5.1 Explain the use of named swatches versus unnamed colors.

Which InDesign feature lets you choose named spot colors, such as those in a Pantone color 
library?

A. Color panel

B. Swatches panel

C. Library panel 

D. Kuler panel

Correct answer: B

6.4 Synchronize master pages, styles, and swatches in a book

You have added several documents to a book panel. The documents each contain text, graph-
ics, styles, transparency, multiple master pages, and other document formatting. Which feature 
can be synchronized across all the documents in the book?

A. Master pages

B. Page size 

C. Optical Margin Alignment

D. Display settings

Correct answer: A
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7.3 Create functional hyperlinks in exported PDF documents or SWF files (options 
include Hyperlinks panel, Table of Contents, Cross-References, and Buttons).

You have been given an InDesign document with hyperlinks applied to several sections of 
text. The hyperlinks all appear on screen and in the exported PDF file with black rectangles 
around them. How do you remove the black rectangles?

A. Double-click the hyperlink in the Hyperlinks panel and choose Invisible Rectangle from 
the Type pop-up menu

B. Double-click the hyperlink in the Hyperlinks panel and choose None from the Highlight 
pop-up menu

C. Click on the hyperlink text with the Direct Selection tool and set the stroke color to None

D. Select the hyperlink in the Hyperlinks panel and choose Hyperlink Destination Options 
from the panel menu

Correct answer: A

8.3 Given a scenario, choose the correct features and settings to create an interactive 
PDF file.

You have an interactive document that you want to export as an Interactive PDF file. When it 
opens in Acrobat Reader or Acrobat, you want to ensure that the pages automatically turn and 
the page transitions work. What should you do?

A. In the Export Interactive PDF dialog box, select the Open in Full Screen Mode check box.

B. In the Export Interactive PDF dialog box, choose Single Page Continuous from the Layout 
pop-up menu.

C. Choose View > Screen Mode > Presentation before exporting the layout to PDF (Interac-
tive) format.

D. Choose Include All in the Buttons and Media section of the Export Interactive PDF dialog 
box.

Correct answer: A

8.5 Map styles to tags and XML tags to styles using the Tags panel and the Structure 
view.

You want to use the Map by Name function in the Map Tags to Styles dialog box. Which con-
ditions must be true?

A. XML tags and paragraph and character style names must match exactly

B. Paragraph and character styles must be sorted alphabetically before mapping to XML 
tags.
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C. All paragraph and character styles must be used at least once within the document 

D. There must be the same number of paragraph and character styles as there are XML tags 
in the Tags panel.

Correct answer: A

9.4 Given a scenario, choose the appropriate PDF Preset or PDF Export settings.

You have a document that contains buttons and hyperlinks that you want to export to PDF and 
place on a Web site for download. You also want your audience to be able to print the docu-
ment. How should you create the PDF file? 

A. Choose File > Adobe PDF Preset > PDF/X-4:2008, and then select the Hyperlinks check 
box in the Export Adobe PDF dialog box.

B. Choose File > Adobe PDF Preset > [High Quality Print], and then select the Hyperlinks 
check box in the Export Adobe PDF dialog box.

C. Choose File > Export, and then select Adobe PDF (Interactive) from the Format menu. 

D. Choose File > Export, select Adobe PDF (Print) from the Format menu, then choose 
Include Appearance from the Interactive Elements pop-up menu.

Correct answer: C


